Description Tutorial

EDVSM
TUTORIAL

Chapter

Description

This tutorial is based on the EDVSM validation study described in SAE Paper
No. 970895 [4]. The validation study includes a curb-tripped rollover of a Ford
Bronco II. In this tutorial, we extend this validation study by illustrating how a
tire blow-out at various wheel positions affects the vehicle response.

Like all EDVSM events, the procedure involves the following basic steps:
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* Create the vehicle(s)

* Create the environment

* Execute the EDVSM event(s)

* Review the EDVSM output reports

This basic procedure is described in detail in this tutorial.

[ NOTE: Itis assumed that HVE is up and running, and
that the user is familiar with HVE’s basic features, such
as using HVE’s dialogs and viewers, as well as the HVE
Editors. The purpose of this tutorial is to illustrate those
features while setting up and executing an EDVSM event.



EDVSM Getting Started

Getting Started

Asin other tutorials, before we get started with our current tutorial, let’s set the
user options so we’re all starting on the same page.

5> NOTE: Most options simply affect the appearance in a
viewer during Event or Playback mode. However, some
options affect the data used in the analysis.. For example, if
AutoPosition is On, the vehicle position conforms to the local
surface; otherwise, the position is set by the
Position/Velocity dialog. Obviously, the resulting difference
in initial conditions could substantially change the event.

5> NOTE: Some of the following options are “Toggles” that
switch between two different modes. Make sure these
options are set correctly.

To set the initial user options, choose the following from the Options Menu:

> ON: Show Key Results

> OFF: Show Axes

> OFF: Show Contacts

> OFF: Show Velocity Vectors
> ON: Show Skidmarks

> OFF: Show Targets

> ON: AutoPosition

> Units equals U.S.

> Render Options:

* Show Humans as Actual

» Show Vehicles as Actual

* Phong Render Method

» Complexity equals Object

* Render Quality equals 5.

» Texture Quality equals /

* Anti-aliasing equals /
The remaining options will automatically initialize to their default conditions.
We’re now ready to proceed with the tutorial.

Our goal is to use EDVSM to simulate a handling experiment conducted by the
University of Missouri [6]. This tutorial shows us how to perform this
simulation.
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Creating the Vehicle

First let’s add the vehicle to our case. The vehicle is a yellow 1984 Ford
Bronco II:

> If the Vehicle Editor is not the current editor, choose Vehicle
Mode. The Vehicle Editor is displayed.

> Click Add New Object. The Vehicle Information dialog is
displayed. The Vehicle Information dialog allows the user to
select the basic vehicle attributes according to Type, Make,
Model, Year and Body Style.

5> NOTE: The Vehicle Information dialog also allows you to
edit the Driver Location, Engine Location, Number of
Axles and Drive Axle(s). The Ford Bronco Il is a 4-wheel
drive vehicle, but we’re going to select 2-wheel drive for
the tutorial.

> Using the option buttons, click each button to choose the
following vehicle from the Vehicle Database:

* Type = Sport-Utility

* Make = Ford

* Model = Bronco 11

* Year=1984-1991

* Body Style = 2-Door
* Drive Axle = Axle 2
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5> NOTE: The Ford Bronco Il is a 4-wheel drive vehicle.
Because it was used in 2-wheel drive mode during the
handling experiments, we must edit the default Drive Axle
option.

> Edit the defaultname; enter Ford Bronco 11, Loaded.

> Click OK to add Ford Bronco, Loaded to the Active Vehicles
list.

The Ford Bronco 11 is displayed in the viewer, as shown in Figure 5-1.
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Figure 5-1 Ford Bronco /I, Loaded before editing.

Editing the Vehicle

Next, we will edit the vehicle to change its color and inertias (the test vehicle
was fitted with outriggers to prevent a catastrophic rollover; these outriggers
and other test equipment affected the vehicle’s inertial properties). In addition,
we’ll add an anti-sway bar to the rear suspension, and disable the left, front
brake (this was done as part of the handling experiment to help ensure
directional control and test repeatability).

To edit the color, perform the following steps:

> Click onthe CG and choose Color. The Vehicle Color dialogis
displayed (see Figure 5-2), showing the vehicle’s current color
(the small black square, or hot spot, in the color wheel) and
intensity (the arrow in the intensity slider). Click on the hot
spot and drag it to the yellow area. To lightenthe vehicle, click
on the intensity slider and drag it to the far right end of the
range.

[[=53° NOTE: The color chip on the left shows the current color.
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Figure 5-2 Vehicle Color
dialog, used for assigning the
vehicle color.

> When the color is lightened to your liking, press the Close
button to apply the new vehicle color.

5> NOTE: The vehicle’s apparent color may be slightly
misleading because the vehicle is translucent when
displayed in the Vehicle Editor. The actual color will be
used whenever the vehicle is displayed during Event and
Playback mode.
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Next, let’s change the weight and rotational inertias to account for the
outriggers installed on the test vehicle to prevent rollover. Perform the
following steps:

> Click on the CG and choose Inertias. The Inertias dialog is
displayed, and we’re ready to change the vehicle’s inertias.

> In the Total Weight text field, replace the existing weight,
3594, with the measured (test) value, 4329. 2 1b.

5> NOTE: The dialog might initially display 3593.906, or a
similar number because the weight is actually divided by
the current gravity constant and stored as mass. Extra
precision results when the mass is multiplied by the
current gravity constant and redisplayed.

> In the Sprung Inertia, Roll text field, replace the existing roll
inertiaj 3133.83, with the measured value, 5372.4
Ib-sec”-in.
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Figure 5-3 Vehicle Inertias dialog, used for editing the current
weight and roll and pitch and yaw rotational inertias.

> Inthe Sprung Inertia, Pitch textfield, replace the existing pitch
inertia, 21680.97, with the measured value, 23666.9
Ib-sec”-in.

> Inthe Sprung Inertia, Yaw text field, replace the existing yaw
inertia, 23239.0, with the measured value, 26100.85
Ib-sec”-in.

The Inertias dialog now appears as shown in Figure 5-3.
> Press OK to accept the new weight and rotational inertias.
Next, let’s add a 1-inch the anti-sway bar at the rear suspension:
> Click on ecither rear wheel. The Wheel pop-up menu is
displayed.

> Choose Suspension. The Suspension Information dialog for
the selected wheel is displayed (see Figure 5-4).

> Choose Springs and Shocks. The Springs and Shocks dialog
for the selected wheel is displayed.

> In the Auxiliary Roll Stiffness data field, replace the existing
value, 0.00, with the calculated value for a 1-inch anti-sway
bar, 1310. 0 in-lb/deg. The dialog now appears as shown in
Figure 5-5.

> Press OK to accept the new auxiliary roll stiffness.
> Press OK againto remove the Suspension Informationdialog.

5-6
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Figure 5-4 Vehicle Suspension Information dialog, used for selecting various suspension
data groups for editing.

Finally, let’s disable the left front brake by setting its brake torque ratio to zero:

> Click on the left front wheel. The Wheel pop-up menu is
displayed.

> Choose Brake. The Brake Assembly dialog for the left front
wheel is displayed.

> In the Torque Ratio data field, replace the existing value,
27.66 in-1b/psi, with the desired value, 0 . 0, to disable the left
front brake. The dialog now appears as shown in Figure 5-6.

> Press OK to accept the modified brake torque ratio for the left
front wheel.

The vehicle is now ready for use in our events. Using the viewer thumb wheel,
rotate and look at the vehicle. Note that the thumb wheels rotate the vehicle
about the viewer axes, not the vehicle axes.
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Figure 5-5 Springs and Shocks dialog, used for editing the current auxiliary roll stiffness
due to the anti-sway bar.
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Figure 5-6 Wheel Brake dialog, used for editing the brake parameters for the
left front wheel.
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[ NOTE: Remember HVE's 3-D viewers have 2 modes:
Pick and Manipulate (the icon in the upper right corner of
the viewer displays the current mode). In Pick mode, you
can use the thumb wheels to adjust the view. In
Manipulate mode, you can use the left mouse button to
rotate the view and the middle mouse button the pan
back and forth. Referto the HVE User's Manual,
Overview (Window Manager Basics) for more information
about using HVE’s viewer controls.
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Creating the Environment

Now, let’s add the environment:

> Choose Environment Mode. The Environment Editor is
displayed.

> Click on Add New Object. The Environment Information
dialog is displayed.

> Using the Location Database combo box, choose Jefferson
City, Missouri, USA. The latitude (38.58N), longitude
(92.20W) and GMT, hours from the prime meridian (-6.00),
are displayed for the selected location.

> Edit the date and time of the experimental study, 7-11-93
and 1500, respectively.

> Edit the angle from true north to the earth-fixed X axis in our
environment, 165 degrees.

[[g NOTE: The Latitude, Longitude, GMT, Date/Time and
angle from true north are used to position the sunin the
scene. This is, of course, important because the sunis
the primary light source for the scene.

> Edit the default environment name; enter Jefferson City
Airport.

> To add the environment geometry file to our case, click on
Open. The Environment Geometry File Selection dialog is
displayed.

> Clickonthe Files of Type optionlist and choose #3d Files.
A list of environment geometry files using the HVE file
format is displayed in a list box. Double-click on
EDVSMValidAASHTOCurb.h3d to choose the environment
file and remove the dialog.

> Press OK.

The selected environment is added to our case and displayed in the
Environment Viewer (see Figure 5-7). Use the viewer thumb wheels to view
the scene.

Saving the Case

Now that we’ve created all the objects (vehicle and environment) for our case,
let’s save the case file.
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Figure 5-7 3-D Environment used for our EDVSM tutorial.

> Click on the File menu and choose Save. The Save-as File
Selection dialog is displayed.

3> NOTE: The Save-as dialog is displayed because the
case has not been saved previously, so we need to enter
a filename.

> In the Case Title text field, replace Untitled with EDVSM
Tutorial Case.

3> NOTE: The Case Title is displayed as a heading on all
printed output reports.

> Place the mouse cursor in the Filename text field and enter
EdvsmTutorial.

> Click SAVE. The current case data are saved in the
hve/supportFiles/case subdirectory.

3> NOTE: Saving the file occasionally is a highly
recommended practice.
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Creating the Events

As mentioned at the outset of the tutorial, our EDVSM tutorial includes several
events. The first event is a curb-tripped rollover prepared as part of the EDVSM
validation project. The next four events simply use the first event, and introduce a
blow-out at cach of the four tires.

Rollover Validation Event

To create the rollover event, perform the following steps:

> Choose Event Mode. The Event Editor is displayed.

> Click on Add New Object. The Event Information dialog is
displayed.

> Select Ford Bronco 11, Loaded from the Active Vehicleslist.

> Select EDVSM from the Calculation Method options list.

> Enter a name for the event, Curb-tripped Rollover.

5> NOTE: HVE will append the name of the calculation
method to the event name, thus the complete event
name will become “EDVSM, Curb-tripped Rollover.”

> Press OK to display the event editor.
Now, we’re ready to set up the first event.

> Using the Event Editor dialog, select Ford Bronco II, Loaded
from the Event Humans & Vehicles list, then choose Set-up
from the menu bar and select Position/Velocity. The Ford
Bronco is displayed at the earth-fixed origin.

> If the Bronco is not visible in the viewer, use the Dolly thumb
wheel to dolly back until the Bronco becomes visible. Then,
pan the viewer until the vehicle is in the center of the viewer,
and dolly back in (a good exercise in using viewers!).

> Click on the vehicle’s X-Y manipulator (see Figure 5-8), wait
forit to turn bright yellow (indicating it has been selected), and
drag it to its initial position, X=123 ft, Y=0 ft. Its initial
heading angle is 0 degrees and need not be modified.

5> NOTE: Be sure to keep the mouse button depressed
while you drag the manipulators.

5> NOTE: Adjust the viewer by dollying back (using the Dolly
thumb wheel) until you can see enough of the entire
scene.
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Figure 5-8 Vehicle positioning using the HVE Event Editor. The manipulators can be used
to drag and drop the vehicle into position.

NOTE: To select the X-Y manipulator, the viewer must be
in Pick mode, as indicated by the highlighted arrow in the
upper right corner of the viewer (see Figure 5-8).

5> NOTE: If you can't position the vehicle at the exact
coordinates, simply enter them in the dialog (in fact, it's often
easier to directly enter the coordinates using the dialog).
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> Click the Velocity Is Assigned checkbox. Enter the initial
velocity, 20 mph.

5> NOTE: Remember to press Apply or <Enter> after
entering a value; otherwise the value is not assigned!

The vehicle initial conditions are now established. Let’s enter the driver
controls. The steering inputs were obtained from the validation study
[reference 4]. However, the throttle, brake and gear selection were not
documented in the study and were determined by repeated adjustments until
the correct vehicle acceleration was achieved.
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Steering Input

To enter the steer angles, perform the following steps:

> Click on the Set-up Menu, select Driver Controls. The Driver
Controls dialog is displayed with an empth steer table.

> Click on the Table option list and choose the A¢ Axle option.
> Enter the steer angles for the front wheels, as shown below:

Table 5-1 Steer Table entries for the Ford Bronco.

Steer Angle at Axle (degrees)

Right Front Left Front
0.00 0.00 0.00
7.42 0.20 0.20
7.97 1.19 1.19
8.63 3.50 3.50
10.21 4.00 4.00
12.00 4.00 4.00

The steering table is now ready for our event.
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Throttle Input

To enter the throttle table, perform the following steps:

> Click on the Driver Controls dialog’s Throttle tab. The
Throttle Table is displayed.

> Click on the Table option list and choose the Wide-open
Throttle option.

> Enter the throttle position, as shown below.

Table 5-2 Throttle Table entries for the Ford Bronco.

Throttle Position

(Percent WOT)
0.00 0.78
5.30 0.78
7.50 0.60
10.30 0.57
10.40 0.00

The throttle table is now ready for our event.
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Gear Selection Input

To enter the steer angles, perform the following steps:

> Click on the Driver Controls dialog’s Gear tab. The Gear
Selection Table is displayed.

> Click on the Number of Shifts option list and choose 1 Shift.
> Enter the time and gear selection, as shown below:

Table 5-3 Gear Selection table entries for the Ford Bronco.

Gear Selection

0.00 Shift Into 2nd

NOTE: The gear selection and throttle tables were
created by trial and error as required to match the
experimental and simulated velocity profiles.

Brake Input

To enter the brake input, perform the following steps:

> Click on the Driver Controls dialog’s Brakes tab. The Brake
Table is displayed.

> Click on the Table Is option list and choose Pedal Force.
> Enter the brake pedal force, as shown below:

Table 5-4 Brake Table entries for the Ford Bronco.

Brake Pedal Force

(Ib)
10.30 0.00
10.40 10.75

> Press OK to accept the driver control tables.

The driver control inputs are now complete.
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Simulation Controls

This event lasts more than 5 seconds. To prevent premature termination, let’s
increase the default maximum simulation time.

> Click on the Options menu and choose Simulation Controls.
The Simulation Controls dialog is displayed.

> Edit the Maximum Simulation Time, changing it from 5 to 15
seconds.

> Press OK to update the simulation controls.

Key Results

Let’s look at some Key Results during execution:

> If the Key Results window is not displayed, choose Show Key
Results from the Options menu.

> Drag the Key Results window to a convenient location, where
it does not block the view but still allows access to the viewer
thumb wheel controls (in case we want to change the view).

> Click on Select Variables inthe Ford Bronco II, Loaded Key
Results window. The Variable Selection dialog for Ford
Bronco II, Loaded is displayed.

The vehicle kinematics are already selected. Let’s add Tire Fx’, Fy’, Fz’ and
Steer Angle to the Key Results window:

> Click Tires, Axle 1, Right, Outer from the variable group list.
The Variable Selection list for the right front tire is displayed
(see Figure 5-9).
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5> NOTE: For calculation methods that support dual-tired
vehicles, you can select the ‘Inner’ or ‘Outer’ tire;
however, EDVSM does not support dual tires.

> Select Fx’, Fy’, and Fz’ tire forces from the list.
> Repeat the above steps by choosing the tire forces for the left
front, right rear and left rear tires.
Now, let’s add the wheel steer angles to our Key Results window:

> Click Wheels, Axle 1, Right from the variable group list. The
Variable Selection list for the right front wheel is displayed.

> Choose Delta from the Variable Selection list.

> Repeatthe above steps to choose Delta for the left front wheel.

> Press OK to add the selected variables to the Key Results
window.
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Figure 5-9 Key Results Variable Selection dialog, used for
selecting variables to be displayed in the Key Results window

Now, we’re ready to execute the event.

> Using the Event Controller, click Play to execute the event.

Allow the event to run until the vehicle strikes the curb and
rolls over.

5> NOTE: The simulation terminates with an error because
the vehicle travels beyond the terrain boundary.

The EDVSM event is shown in Figure 5-10.

@ NOTE: While the event is executing, watch the current
results in the Key Results windows.

We have now completed the first event.
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Figure 5-10 HVE Event Editor executing the EDVSM Curb-tripped Rollover event.
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Creating Tire Blow-out Simulations

The next four events in our Tutorial use EDVSM to study the vehicle’s response to
a loss of pressure at various tire locations during a cornering maneuver. In this
parameter study, we will change only the wheel location at which the blow-out
occurs, so any difference invehicle response is attributable solely to the location of
the blown tire. To simplify our study, we’ll use the current environment.

To study the effect of a blow-out at the right front tire, perform the following
steps:

> Click on Add New Object. The Evenl Infonmationdialog is displayed.

> Select Ford Bronco I1, Loaded fromthe Active Vehicleslist.

> Select EDVSM from the Calculation Method options list.

> Edit the event name: R/F Tire Blow-out.

> Press OK to display the event editor.

Now, we’re ready to set up (i.c., supply position, velocity, driver controls and
tire blow-out parameters) for the right front tire blow-out event.

> Choose Set-up from the menubar and select Position/Velocity.
The Ford Bronco is displayed at the earth-fixed origin.

> Using the Position/Velocity dialog, enter the vehicle’s initial
position, X=123 ft, Y=0 ft. Its initial heading angle is 0
degrees and need not be modified.

> Click the Velocity Is Assigned checkbox. Enter the initial
velocity, 50 mph.

The vehicle initial conditions are now established. Let’s enter the driver
controls. Only steering inputs need to be supplied. To enter the steer angles,
perform the following steps:

> Choose Set-up from the menu bar and select Driver Controls.
The Driver Controls dialog is displayed with the default steer
table. The default steer table option, At Steering Wheel, is the
option we’ll use in our study.

> Enter the steering wheel angles, as shown below:

Table 5-5 Steer Table entries for the EDVSM Blow-out Studies events.
(The same table will be used for all blow-out simulation events.)

Steer Angle
at Steering Wheel
(deg)
1.00 0.0
1.50 45.0
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Figure 5-11 HVE Wheels dialog with Tire Blow-out Model option.

> Press OK to accept the steer table.
Now, let’s set up the HVE Tire Blow-out Model.

> Choose Set-up from the menu bar and select Wheels. The
Wheelsdialog is displayed with the Tire Blow-out information
(see Figure 5-11).

> (lick on the Axle No. option list and choose Axle No. 1. Click
onthe Right side radio button. Click inthe Tire is Blown check
box. The default blow-out parameters for the right front tire
are displayed.

> Enter the Start Time, 3.0 seconds.
> Enter the Duration, 0.2 seconds.
> Enter the Stiffness Factor, 0.10.
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[5° NOTE: The Stiffness Factor reduces the tire’s radial tire
stiffness, cornering stiffness and camber stiffness.

> Enter the Rolling Resistance Factor, 1 0.

[5>° NOTE: The Rolling Resistance Factor increases the tire
rolling resistance.

> Press OK to apply the tire blow-out parameters.
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Figure 5-12 HVE Event Editor executing the EDVSM R/F Tire Blowout simulation.

Now, we’re ready to execute the event.

> Using the Event Controller, click Play to execute the event to
simulate the loss of pressure at the right front tire. Allow the
eventto rununtil the simulationterminates at t=35.00 seconds.

The EDVSM event is shown in Figure 5-12.

[[g NOTE: While the event is executing, watch the current
results in the Key Results windows.

To study the effect of a blow-out at the left front tire, perform the following
steps:

> Click on Add Event. The Event Information dialog is
displayed.

> Select Ford Bronco I, Loaded fromthe Active Vehicleslist.

> Select EDVSM from the Calculation Method options list.

> Enter a name for the event, L/F Tire Blow-out.

> Press OK to display the event editor.

5-22



Creating the Events Tutorial

Repeat the steps used in the previous event to set up our left front tire blow-out
simulation:
> Choose Set-up from the menu bar, select Position/Velocity.

> Directly enter the vehicle’s initial position, X=123 ft, Y=0 ft.
Itsinitial heading angle is O degrees and need notbe modified.

> Click the Velocity Is Assigned checkbox. Enter the initial
velocity, 50 mph.
To enter the steer angles, perform the following steps:
> Click on the Set-up Menu, select Driver Controls. The
Steering Table dialog is displayed.
> Enterthe steering wheel angles, as shownearlier in Table 5-5.
> Press OK to accept the steering table.
Now, let’s set up the HVE Tire Blow-out Model.
> Choose Set-up from the menu bar and select Wheels. The
Wheels dialog is displayed with the Tire Blow-out information.

> (Click on the Axle No. option list and choose Ax/e No. 1. Click
on the Lefi side radio button. Click inthe Tire is Blown check
box. The defaultblow-out parameters for the left front tire are
displayed.

> Enter the Start Time, 3.0 seconds.

> Enter the Duration, 0.2 seconds.

> Enter the Stiffness Factor, 0.10.

> Enter the Rolling Resistance Factor, 1 0.

> Press OK to apply the tire blow-out parameters.

-
g
14
(©)
-
=)
-

Now, we’re ready to execute the event.

> Using the Event Controller, click Play to execute the event to
simulate the loss of pressure at the left front tire. Allow the
eventto rununtil the simulationterminates at t=35.00 seconds.

The EDVSM event is shown in Figure 5-13.

[@ NOTE: While the event is executing, watch the current
results in the Key Results windows.
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Figure 5-13 HVE Event Editor executing the EDVSM L/F Tire Blowout simulation.

To study the effect of a blow-out at the right rear tire, perform the following
steps:

> Click on Add Event. The Event Information dialog is
displayed.

> Select Ford Bronco II, Loaded fromthe Active Vehicleslist.

> Select EDVSM from the Calculation Method options list.

> Enter a name for the event, R/R Tire Blow-out.

> Press OK to display the event editor.

Repeatthe steps used in the previous event to set up our right rear tire blow-out
simulation:

> Choose Set-up from the menu bar, select Position/Velocity.

> Directly enter the vehicle’s initial position, X=123 ft, Y=0 ft.
Its initial heading angle is O degrees and need not be modified.

> Click the Velocity Is Assigned checkbox. Enter the initial
velocity, 50 mph.
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Figure 5-14 HVE Event Editor executing the EDVSM R/R Tire Blowout simulation.

To enter the steer angles, perform the following steps:
> Click on the Set-up Menu, select Driver Controls. The
Steering Table dialog is displayed.
> Enterthe steering wheel angles, as shownearlier in Table 5-5.
> Press OK to accept the steering table.

Now, let’s set up the HVE Tire Blow-out Model.
> Choose Set-up from the menu bar and select Wheels. The
Wheels dialog is displayed with the Tire Blow-out information.

> Click onthe Ax/e No. option list and choose Axle No. 2. Click
onthe Right side radio button. Click inthe Tire is Blown check
box. The defaultblow-out parameters for the right rear tire are
displayed.

> Enter the Start Time, 3.0 seconds.

> Enter the Duration, 0.2 seconds.

> Enter the Stiffness Factor, 0.10.

> Enter the Rolling Resistance Factor, 1 0.

> Press OK to apply the tire blow-out parameters.
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Figure 5-15 HVE Event Editor executing the EDVSM L/R Tire Blowout simulation.

Now, we’re ready to execute the event.

> Using the Event Controller, click Play to execute the event to
simulate the loss of pressure at the right rear tire. Allow the
eventto rununtil the simulationterminates at t=35.00 seconds.

The EDVSM event is shown in Figure 5-14.

[[g NOTE: While the event is executing, watch the current
results in the Key Results windows.

To study the effect of a blow-out at the left rear tire, perform the following
steps:
> Click on Add Event. The Event Information dialog is
displayed.
> Select Ford Bronco II, Loaded fromthe Active Vehicleslist.
> Select EDVSM from the Calculation Method options list.
> Enter a name for the event, /R Tire Blow-out.

> Press OK to display the event editor.
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Repeat the steps used in the previous event to set up our left rear tire blow-out
simulation:
> Choose Set-up fromthe menubarand select Position/Velocity.

> Directly enter the vehicle’s initial position, X=123 ft, Y=0 ft.
Itsinitial heading angle is O degrees and need notbe modified.

> Click the Velocity Is Assigned checkbox. Enter the initial
velocity, 50 mph.
To enter the steer angles, perform the following steps:
> Click on the Set-up Menu, select Driver Controls. The
Steering Table dialog is displayed.
> Enterthe steering wheel angles, as shownearlier in Table 5-5.
> Press OK to accept the steering table.
Set up the HVE Tire Blow-out Model.
> Choose Set-up from the menu bar and select Wheels. The
Wheels dialog is displayed with the Tire Blow-out information.

> (Click on the Axle No. option list and choose Ax/e No. 2. Click
on the Lefi side radio button. Click inthe Tire is Blown check
box. The default blow-out parameters for the left rear tire are
displayed.

> Enter the Start Time, 3.0 seconds.

> Enter the Duration, 0.2 seconds.

> Enter the Stiffness Factor, 0.10.

> Enter the Rolling Resistance Factor, 1 0.

> Press OK to apply the tire blow-out parameters.
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Now, we’re ready to execute the event.

> Using the Event Controller, click Play to execute the event to
simulate the loss of pressure at the left rear tire. Allow the
event to run until the simulationterminates att=5.00 seconds.

The EDVSM event is shown in Figure 5-15.

U@ NOTE: While the event is executing, watch the current
results in the Key Results windows.

We have now created four events simulating a tire blow-out. The only
difference in these events is the location of the blown tire. Thus, any
differences in vehicle behavior are attributable solely to the location of the
blown tire.
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Observations

Note the vehicle is in a right turn, thus the vertical tire force is shifted from the
right-side to the left-side tires. As a result, the left-side (outside) tires are more
heavily loaded and produce a greater portion of the cornering force.

Itfollows, then, that ablow-out in the left-side tires should have a greater effect
on vehicle handling and controllability. This fact is confirmed by the
simulation results.

Note also the difference in vehicle cornering response for blow-outs at the
front tires compared to the rear tires. Front tire blow-outs cause the vehicle to
tend to maintain a straight-ahead path, or plow. This is generally referred to as
an understeer characteristic. For rear tire blow-outs, the vehicle tends to
become unstable and spin out. This is generally referred to as an oversteer
characteristic. Oversleer is generally considered an undesirable characteristic,
although a small tendency for oversteer is often designed into
high-performance vehicles.

Spend a few minutes reviewing each event, noting how the location of the
blowntire affects response. You'll find this procedure useful the next time you
need to reconstruct an accident involving a tire blow-out.

It is quite instructive to look carefully at all tire forces (Fx’, Fy>, Fz’) before,
during and after the blow-out to learn exactly how a blown tire affects vehicle
behavior.

5> NOTE: Look carefully; you'll see a lot of interesting
phenomena taking place.

You might also find it interesting to change the amount and timing of the
steering and introduce braking to observe the effect on vehicle behavior for the
various blown-tire locations. The blow-out model is extremely powerful! For
additional information about vehicle response to tire blow-out, see reference

[7].

One final, but very important point: This tutorial involves a Ford Bronco I1.
This particular vehicle was selected because it was included in a rigorous
validation study involving vehicle rollover [6]. In this study, the vehicle was
subjected to extremely violent experimental conditions (i.e., curb-tripped
impact) in an effort to induce a rollover response. The Ford Bronco II's
response to these conditions, as well as to the tire blow-out simulations
included in this tutorial, is substantially the same as the response of other
multi-purpose vehicles.
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Viewing Results

Now that we have produced our ED VSM simulations, let’s take a detailed look
at the results. The Playback Editor is used for reviewing and printing reports
for cach event in the current case, as well as for producing video output.

EDVSM produces the following reports:

» Messages - A list of messages produced by the current run
» AccidentHistory - A table of initial and final positions and velocities

* Environment Data - A list of the visual and physical environment
parameters used by EDVSM.

» Vehicle Data - A series of tables containing the vehicle data used by
EDVSM, including tire blow-out information

* Program Data - A table containing program control information

» Variable Output - A table containing user-selectable, time-dependent
simulation results

» Trajectory Simulation - A 3-D visualization of the event, displayed
at a user-selectable time interval

- Damage Profiles - A 3-D visualization of the vehicle damage,
displayed at a user-selectable time interval

To view the output reports, we need to be in Playback mode:
> Choose Playback Mode. The Playback Editor is displayed.
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5> NOTE: Our tutorial uses the Curb-tripped Rollover event
to illustrate the procedures for viewing output reports.
You can use the same procedures for viewing reports for
any of the events in the case.
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Report Windows

The reports listed on the previous page are displayed by selecting Preview
Windows. Each Report Window contains an individual report.

Report Window EE4d |

&ctive Events

ok
EDWSH, LAF Tire Blow-out
EDWSH. BAR Tire Blove-out
EDWSH, L/R Tire Blove-out

Wiindow Marne
|ED"-“SM, Curb-tripped Rallowver

Select Output
I.-'-‘-.ccident Hiztory j

| Ok, I Cancel |

Figure 5-16 Report Window Information
dialog, showing the name of each event in
the current case.

To view the reports produced by the EDVSM, Curb-tripped Rollover event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialogis displayed, as shown in Figure 5-16, and includes a list
of the active events (EDVSM, Curb-tripped Rollover 1is the
event whose output we’ll review in this tutorial). The Report
Window Information dialog also includes the user-editable
Report Window Name text field and Selected Output option
list.

> Select EDVSM, Curb-tripped Rollover fromthe Active Events
list.

> Click on the Selected Output option list and choose any of the
available reports.

> Press OK to display the report.

The selected report will be displayed in a resizable window. The following
pages illustrate the reports produced for the EDVSM, Curb-tripped Rollover
event.

5-30
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Messages

EDVSM produces a number of messages, depending on the outcome of the event.
For a complete listing and explanation of the messages, refer to Chapter 6.

2, M ezzages-EDYSM, Curb-tripped Rollover

E
r
_

MEZZAGES

The simulation was terminated bhecause no terrain exists beneath the wehicle
and a rollower is under way. To continue the rollower simulation, ensure
that a terrain exists beneath the wvehicle.

A H 4

Figure 5-17 Messages report for EDVSM, Curb-tripped Rollover.

To view the reports produced by the EDVSM, Curb-tripped Rollover event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialogis displayed, as shownin Figure 5-17, and includes a list
of the active events.

> Select EDVSM, Curb-tripped Rollover from the Active
Events list.

> Click onthe Selected Output optionlistand choose Messages.
> Press OK.

The Messages report is displayed for the EDVSM, Curb-tripped Rollover
event, as shown in Figure 5-17.
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Accident History

The Accident History report displays the time and total distance traveled, as
well as the position and velocity at the start and end of the run.

4, Accident History-ED¥SM. Curb-tripped Rollover

ACCIDENT HISTORY

Total Distance Travelled [(£t): L7556
Time [sec): 11. 2771
Position Welocity
X T PSI V-tot u-wel w-wel Yaw Vel
L) [£t) fdeg) [uph) {mph) fuph)  (deg/sec)
Initial: 123.00 0.00 a.0a0 z0.00 z20.00 0.00 a.0a0
Final: 663,40 130. 46 51.18 36.29 33.54 -5.53 27.87
-
A 1%

Figure 5-18 Accident History report for EDVSM, Curb-tripped Rollover.

To view the Accident History report for the EDVSM, Curb-tripped Rollover
event, perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.

> Select EDVSM, Curb-tripped Rollover fromthe Active Events list.

> Click onthe Selected Output optionlist and choose Accident History.

> Press OK.

The Accident History report is displayed for the EDVSM, Curb-tripped
Rollover event, as shown in Figure 5-18.
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Environment Data

The Environment Data report displays the physical and visual parameters
describing the environment.

4, Environment Data-EDVSM. Curb-tripped Rollover

GENERAL ENVIRONMENT DATL

Aubient Temperature (Farenheit): 65.00
Aubient Pressure [in-Hi): 29.91
Gravity Constant (in/sec*2): 386.40

3-D ENVIRONMENT TEERAIN DATA

3-D Geometry Filename: | Unknowt )
Number of Polygons: 8065
GetiurfaceInfo: From Previous Polygon
Minimum Terrain Elevation (£t): 0.03
Maximum Terrain Elevation (£t): -0.30
-
A 1%

Figure 5-19 Environment Data report for EDVSM, Curb-tripped Rollover.

To view the Environment Data report for the EDVSM, Curb-tripped Rollover
event, perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.

> Select EDVSM, Curb-tripped Rollover from the Active Events
list.

> Click on the Selected Output option list and choose
Environment Data.

> Press OK.

The Environment Data report is displayed for the EDVSM, Curb-tripped
Rollover event, as shown in Figure 5-19.
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Vehicle Data

The Vehicle Data report for EDVSM contains all the vehicle data groups
(Sprung Mass, Suspension, Tire, Brake and Driver Controls).

4. Wehicle Data-EDVSM, Curb-tripped Rollover
WEHICLE DATA
General Vehicle Information
Vehicle MName: Ford BEronco II, Loaded
Owverall Length (in): 155. 50
Owerall Width (in): 85,00
CG to Front End (in): 74,00
CG to Rear End (in): -§4. 50
Theelbase (in): 94. 00
Front Track Width (in): 56. 50
Rear Track Width [(in): 56,60
Front Owerhang (in): 25.40
Rear Owverhang (in): -36.10
CG to Front Axle (in): 45. 60
CG to Rear Axle [(in): -45. 40
CG Height Abowe Ground (in): 258.70
Total Weight (1lh): 4329, 20
Effective 4ir Drag (in*2): 0.00007s
Aerodynamic Drag, Cd: 0.4500
Frontal Area (in*2): 2999, 90
Body Data

Number of Body Nodes: 2608
Nunber of Damaged Nodes: 1]
Node Stiffness (lb/in), Front: 167.20
Right: 110.60
EBack: 539,30
Left: 110.60
Top: 100. 00
Bottom: 100.00
Node Friction: 0.500

-

KI ;I_‘

Figure 5-20 Vehicle Data report for EDVSM, Curb-tripped Rollover.

Toview the Vehicle Data report forthe EDVSM, Curb-tripped Rollover event,
perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.
> Select EDVSM, Curb-tripped Rollover from the Active Events list.
> Click onthe Selected Output option listand choose Vehicle Data.
> Press OK.
A portion of the Vehicle Data report is displayed for EDVSM, Curb-tripped
Rollover is shown in Figure 5-20.

5> NOTE: The EDVSM Vehicle Data report is too large to fit
in the viewer. Use the scroll bars to view the entire report.
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Program Data

The Program Data report includes the simulation control parameters and other
run-time information.

4, Program Data-EDVSM. Curb-tripped Rollover

SIMULATION CONTROLS

Integration Method: Fixed Bunge-Kutta

Max Simulation Time [sec): 15.0000
Normal Integration dt (sec): 0.0025
Output Interwal [sec): 0.1000
Linear Term Wel [(mph): 2.00
Angular Term Wel (degssec): 5.00

General Information

EDVSHM Version HNumber: Z.50

Wheel Spin Int. Const 0.00

Term Wheel Spin Vel [degdsec): 5.73

Pitch Index Angle (deg): 70.00
Driweline Inertia (lb-sec*Z-in G. 50 -
KIN ;H

Figure 5-21 Program Data report for EDVSM, Curb-tripped Rollover.

To view the Program Data report for the EDVSM, Curb-tripped Rollover
event, perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.

> Select EDVSM, Curb-tripped Rollover fromthe Active Events
list.

> Click on the Selected Output option list and choose Program
Data.

> Press OK.

The Program Data report is displayed for the EDVSM, Curb-tripped Rollover
event, as shown in Figure 5-21.
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Variable Output

The Variable Output report is a table of user-selectable, time-dependent
simulation results for the current event. To view the Variable Output report for
the EDVSM, Curb-tripped Rollover event, perform the following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.

> Select EDVSM, Curb-tripped Rollover from the Active Events
list.

> Click on the Selected Output option list and choose Variable
Output.

> Press OK.

The Variable Output report is displayed for the EDVSM, Curb-tripped
Rollover event. The table is initially empty, so the next step is to select the
time-dependent results we wish to display in the table.

Variable Selection

The purpose of our EDVSM study is to illustrate a rollover sequence. To
document the resulting path, as well as some other pertinent results, let’s select
the CG path coordinates, velocity and accelerationfrom the Variable Selection
dialog.

> Click on Select Variables in the Ford Bronco II, Loaded
Variable Output window. The Variable Selection dialog for
Ford Bronco II, Loaded is displayed, as shownin Figure 5-22.
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Yanable Selection: EDY5M, Curb-tnpped R._. |

Object Mame : |F|:|r|:| Bronco |, Loaded j

Current % ariable : |Kinematin:s

Output Groupsz ; “ariables ;
Finetics

AccelerometersAccel 1 z
Accelerometers bocel 2 Foall
Accelerometers bocel 3 Fitch
Accelerometers Aocel 4

Accelerometers Accel B Hadius
Damage M

Tirez-fule 1 Right, Outer -tk

Tires-Axle 1 Right lnner Sideslip

Tires-dule 1 Left, Duker L-vel

Tires-Aule 1.Left Inner j ey j

Clear Selection I

Cahzel |

Figure 5-22 Variable Selection dialog, used for selecting results
displayed in the Variable Output table.

The Kinematics Output group is the default selection and the Kinematics
variable list is displayed. Let’s add X, Y, Yaw and Path Radius to the Key
Results window:

> Select X, Y, Z, Roll, Pitch, Yaw, V-tot, Sideslip, u-vel, v-vel,
w-vel, Roll Vel, Pitch Vel, Yaw Vel, Acc-tot, Fwd Acc, Lat Acc,
Vert Acc, p-dot, g-dot and r-dot from the list .

[ NOTE: Feel free to add additional variables to the
Variable Output window. You might be especially
interested in the tire forces.

> Press OK to add the selected variables to the Variable Output
table.

The Variable Output report for the EDVSM, Curb-tripped Rollover event
now includes the selected results (see Figure 5-23).
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EDVSM

4, Wariable Output-EDYSM . Curb-tripped Rollover

[araph... Edi...
- Fard Bronca | Fard Branco | Fard Broncal Fard Bronca | Fard Bronca | Fard Braonca | |_
ime

[zec] = N £ Rl Pitch ' aw
[ft] [Ft] [ft] [deq] [d=q] [d=q]
5.0333 380.5 14.2 2.3 0.3 07 71
5.0GET 3824 14.4 2.3 0.3 07 72
£.1000 3842 146 2.3 0.3 07 72
£.1333 3861 149 2.3 0.3 07 7.3

B.16E7 388.0 15.1 2.3 0.3 07 7.3 |_
£.2000 389.8 15.3 2.3 0.3 07 7.4
5.2333 391.7 15.6 2.3 0.3 06 7.4
B.26E7 3936 15.8 2.3 0.3 06 7h
5.3000 395.5 1E6.0 2.3 0.3 06 7h
5.3333 397.4 1E6.3 2.3 0.3 06 76
5.36E7 399.3 16.5 2.3 0.3 06 76
.4000 401.2 1E6.8 2.3 0.3 06 77
5.4333 4031 17.0 2.3 0.3 06 7.8

- £ ACET ANF 1 177 27 A ne 70 . x

Figure 5-23 Variable Output report for EDVSM, Curb-tripped Rollover, displaying the selected results.
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Trajectory Simulation

Let’s display a trajectory simulation for this event. To view the Trajectory
Simulation for the EDVSM, Curb-tripped Rollover event, perform the
following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.

> Select EDVSM, Curb-tripped Rollover from the Active
Events list.

> Click on the Selected Output option list and choose Trajectory
Simulation.

> Press OK.

The Trajectory Simulation viewer is displayed for the EDVSM, Curb-tripped
Rollover event (see Figure 5-24). The viewer shows the vehicle at its initial
position.

To visualize the motion, perform the following steps:

> Click Play (single right-arrow). The simulation begins and is
displayed at the current Playback output interval.

> Click Pause. The simulation stops.

> Click Reverse (single left-arrow). The simulation plays in
reverse.

> Click Pause. The simulation stops.

> Click Rewind (left arrow with bar). The simulation returns to
the start.

> Click Advance to End (right arrow with bar) the simulation
advances to the end of the run.
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E Traj S5im-EDY¥SM. Curb-tripped Rollover

==

Rotx Roty [T Zoom «| | | 23.4 Dolly

Figure 5-24 Trajectory Simulation for EDVSM, Curb-tripped Rollover, displaying the
vehicle at the moment of rollover.
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Damage Profiles

Finally, let’s display the damage profile simulation for the event. To view the
Damage Profiles for the EDVSM, Curb-tripped Rollover event, perform the
following steps:

> Click Add New Object. The Report Window Information
dialog is displayed.

> Select EDVSM, Curb-tripped Rollover from the Active
Events list.

> Click on the Selected Output option list and choose Damage
Profiles.

> Press OK

The Damage Profiles simulation viewer is displayed for the EDVSM,
Curb-tripped Rollover event (see Figure 2-25). The vehicle is displayed in its
initial condition. To visualize the damage to the vehicle, use the Event
Controller in the same manner as for the Trajectory Simulation.

5" NOTE: Because the Trajectory Simulation enables the
Event Controller, you must have a Trajectory Simulation
open for this event in order to “play” the Damage Profile.

%]

1 Damage Profiles-ED¥SM, Curb-tripped Rollover

® SR~

Rotx Roty [T 1T Zoom 4| | »|| 27.0 Dally
Nesxt Vehicle i Frevious Yehicle |

Figure 5-25 Damage Profile for EDVSM, Curb-tripped Rollover, displaying the vehicle at
the end of the simulation.
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Prinfing

The final step is to print the above reports. Printing reports is simple. All youdo
is choose a report and print it. For example:

> Click on the dialog header of the Variable Output - EDVSM,
Curb-tripped Rollover report. The dialog headeris highlighted
and the Variable Output window pops to the top of the display
(if it isn’t there already), indicating it is the current window.

> Click on the File menu and choose Print. The Print dialog is
displayed, allowing the user to select from several available
print options.

5> NOTE: Alternatively, you can click on the print icon in the
upper menu bar.

> Press OK. The Variable Output report is printed on the system
printer.

That’s all there is to it! You can print any other report using the same three
steps described above.

53> NOTE: The Print dialog provides several options. Refer to
the HVE User’s Manual for more information.

5> NOTE: The font size of both the printed reports and
screen display may be edited by clicking on the Options
menu and choosing Preferences. Use the Font Size
option list to change the size.



